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55920482: PROGRAM: EDUCATION TECHNOLOGY;
KEYWORDS: ELECTRONIC BOOK (E-BOOK) PHOTOSHOP PROGRAM FOR
INSTRUCTIONAL MEDIA PRODUCTION
WARUNEE KONGVIMON: THE DEVELOPMENT OF ELECTRONIC BOOKS
(E-BOOK) ON 'PHOTOSHOP PROGRAM' FOR INSTRUCTIONAL MEDIA PRODUCTION
FOR PRIMARY LEVEL TEACHERS. ADVISORY COMMITTEE : PHUBATE LAUIMSAI,

Ph.D., PONGPRASERT HOKSUWAN, Ph.D. 188 P. 2016.

The aims of this research were: 1. To develop an electronic book (e-Book) on
‘Photoshop Program’ for instructional media production for primary sehool teachers to meet the
90/90 standard criterion, 2. to compare the pre-test and past-test scores after using the developed
electronic book The samples used in this research were thirty primary school teachers at
St. Louis School, Chachoengsao, chosen on a voluntary basis. The instruments used in this
research were e-Book, e-Book quality assessment form, The statistics used for data analysis were
mean standard deviation, percentage and t-test (dependent sample).

The research findings were that the developed Electronic book (e-Book) on Photoshop
Program possessed the efficiency of 91.17/ 90.00 which met he set 90/ 90 eriteria The post-test

score was higher than the pre-test score at .05 statistical significance.
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YU using computers, internet, intranet. In principle e-Learning is a kind of distance learning
NN learning materlals can be accessed from the web or CD via a computer. Tutors and learners
can communicate with each other using e-mail or discussion forums. e-Learning can be used as
the main method of delivery of training or as a combined approach with classroom-based training”
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1. includes content relevant to the learning objective.

2. uses instructional methods such as examples and practice to help learning.

3. uses media elements such as words and pictures to deliver the content and methods,
and

4. builds new knowledge and skills linked to individual learning goals or to improved

organizational performance.
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Wumstiruasyls
. AWHUININ
V. VUIAVDININ
A. ANNAZIDIAVDININ
1. IUIUNN
8. MNA0IMIMrUATLezrIvRAazn e 1A 1uni1A19 Contract Sheet I V04
T5un51 Photoshop A5 MLATITDA 1A
. Use Auto-Spacing
9. Width: , Height:
f1. Flatten All Layers
3. Column: , Rows:
9. Tunti1A19 Contract Sheet 1T Y84 1151053 Photoshop M3taen lnuadan lagilnd
W lasden 1 lwuaduunla
. RBG Color
9. Gray Scale
fl. CMYK Color
3. Lab Color
10. 1unt1A19 Contract Sheet 11 ¥94T1/511n5% Photoshop aaulafilfusuamaniaves
AonyInaantiale
. Thumbnails
U. Document
f1. Use Filename as Caption

3. Source Images
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suunagey unii 6 1589 marhgUammiinaalilélulsunsu Microsoft Office

1. lld3Uamgduunlai Tusunsu Microsoft office Tdaansariusunigan'1d
N. .ipg
V.. png
f.. psd
3. . gif
2. $rdai1gih TSy mmidun1F oy Tusunsy Microsoft office fie f1d7ala
f. Insert > Picture
9. Insert > Clip Art
f1. Format > Picture Border
3. Format > Picture Layout
3. 0131 mindeamsnyugdam Tulusunsy Microsoft Word a5 1dundnanwyulu

Auviala

A, AWHUIN 1

V. AWMU 2
. D4
A, AWMU 3

3. WU 4
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Jd a { o ]
4. 131 mindeamséreginin TuTllsunsu Microsoft Word ad3 1dundnaniidwmiia

o oA
. AUHUIN |

V. @wrLan 2
o ] d’
A, AHUIN 3

3. AnLan 4

v
o 9 Y

Y o Yo o Jou
5. 1131 inaeamsilsuvinavesgdnnnduiusiuiaaunauazen lu

a

o { o [l
T1)511n51 Microsoft Word a3 1ndaanndmiiala

o ' oA
. AUWHUIN 1

V. ArUan 2
A, AWMUIN 3

3. AUNUAN 4
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6. 11031 mindesmstSuvuavesgnimdiuladunils Tullsunsu Microsoft Word

'
a a

9 4 ° 1
s lsnaaanndumvala

v
=1

. Aunuan 1

o [ =
. AURUIN 2

fl.

J.

7. Yolade lonouginmuestjudids nlaesugiawn (Change Picture) TuTisunsy

) A
AL UIN 3

° oA
AU UIN 4

Microsoft Word

8. dalaluTisunsy Microsoft Word A1dinuaginmldiilumioudeniuily

\.

1 d!
AIUNUN

luussia

N

2

)]

Lo

. In Line With Text
. Tight

. Behide Text

. In Front Of Text
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9. rdfalalu Tusunsu Microsoft Word il muagunnling 3uihdeany
. In Line With Text
9. Tight
f1. Behide Text
3. In Front Of Text
10. M31l5uuaaninluT1l5unsy Microsoft Word 1¥idludnyazisuuuifailnng
Smuadfisndala
f. Correction
9. Color
fl. Artistic Effects

3. Picture Border
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ﬂTﬁﬁ”IﬂTﬂ'JﬁJL%ﬂiJusUﬂQ!L‘U‘U‘ﬂﬂﬁ@‘ﬂ W“Ll\iﬁ@'ﬂlﬁﬂﬂﬁ@l!ﬂﬁ (e-Book)
d’ % d’ a 4’ o 1Y [ =
1599 M5 1% 11sunsu Photoshop INDHAATDNITHDU ﬁ?ﬁﬁﬂﬂgﬁ%ﬂﬂﬂigﬂuﬁﬂ'ﬂﬁ

MNFAT KR-20 Y99 Kuder Richardson



MIMIAIANNEOUUYDILLUNATOU (;ﬂ)TL.!’J‘Ll 60 sISIIEJ)

A J 9
M1319N 10 ﬂ1ﬂ’)11J!L‘IJ'§ﬂiﬁuﬂmmu‘ﬂﬂﬁﬂﬂﬂlﬂﬂwiﬂu
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AUN AZUUHU (X)

a
AUN

2

X AZUUU (X) X
1 51 2601 1 25 625
2 51 2601 12 27 729
3 44 1936 13 26 676
4 46 2116 14 24 576
5 45 2025 15 28 784
6 39 1521 16 28 784
7 42 1764 17 27 729
8 42 1764 18 27 729
9 48 2304 19 25 625
10 46 2116 20 19 361
Yx=1710 Y x> =27366
O.x)* = 504100
unua lugas
) NYx?% — (X x)?
S
NZ
. 20(27366) — 504100
400
. i 43220
S
400
s’ - 108.05
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Fofi sy S0 daaauauigniy  daddiuvesnuiie Pq
auign  AuhAA AvIanIA Tuunazdo (q=1-p)
1 12 8 0.60 0.40 0.24
2 11 9 0.55 0.45 0.25
3 13 7 0.65 0.35 0.23
4 14 6 0.70 0.30 0.21
5 10 10 0.50 0.50 0.25
6 10 10 0.50 0.50 0.25
7 11 9 0.55 0.45 0.25
8 13 7 0.65 0.35 0.23
9 10 10 0.50 0.50 0.25
10 11 9 0.55 0.45 0.25
11 12 8 0.60 0.40 0.24
12 10 10 0.50 0.50 0.25
13 12 8 0.60 0.40 0.24
14 10 10 0.50 0.50 0.25
15 12 8 0.60 0.40 0.24
16 15 5 0.75 0.25 0.19
17 12 8 0.60 0.40 0.24
18 10 10 0.50 0.50 0.25
19 11 9 0.55 0.45 0.25
20 15 5 0.75 0.25 0.19
21 13 7 0.65 0.35 0.23
22 14 6 0.70 0.30 0.21
23 11 9 0.55 0.45 0.25
24 12 8 0.60 0.40 0.24
25 12 8 0.60 0.40 0.24
26 11 9 0.55 0.45 0.25
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Fofi  Swou  dnow  dadawawigaiy  dadauvesauihiia Pq
augn  auiiAa AvitanNa lunnazdio (q=1-p)
27 10 10 0.50 0.50 0.25
28 12 8 0.60 0.40 0.24
29 10 10 0.50 0.50 0.25
30 10 10 0.50 0.50 0.25
31 10 10 0.50 0.50 0.25
32 13 7 0.65 0.35 0.23
33 10 10 0.50 0.50 0.25
34 11 9 0.55 0.45 0.25
35 12 8 0.60 0.40 0.24
36 13 7 0.65 0.35 0.23
37 12 8 0.60 0.40 0.24
38 10 10 0.50 0.50 0.25
39 11 9 0.55 0.45 0.25
40 15 5 0.75 0.25 0.19
41 10 10 0.50 0.50 0.25
42 1 9 0.55 0.45 0.25
43 10 10 0.50 0.50 0.25
44 16 4 0.80 0.20 0.16
45 10 10 0.50 0.50 0.25
46 15 5 0.75 0.25 0.19
47 10 10 0.50 0.50 0.25
48 1 9 0.55 0.45 0.25
49 12 8 0.60 0.40 0.24
50 10 10 0.50 0.50 0.25
51 13 7 0.65 0.35 0.23
52 16 4 0.80 0.20 0.16
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Fofi  Swou  dnow  dadawawigaiy  dadauvesauihiia Pq
augn  auiiAa AvitanNa lunnazdio (q=1-p)
53 10 10 0.50 0.50 0.25
54 11 9 0.55 0.45 0.25
55 10 10 0.50 0.50 0.25
56 15 5 0.75 0.25 0.19
57 10 10 0.50 0.50 0.25
58 16 4 0.80 0.20 0.16
59 12 8 0.60 0.40 0.24
60 16 4 0.80 0.20 0.16
>pq=13.97
unuenlugas r, = K- %
K-1 :
20 13.97
fu ™ m{l B 108.05}
r,= 105 (1-0.13)
r, = 1.05 x 0.87
r = 0.91

tt

i1 v 9
agil ey unadeuniiuil Tasldgas KR - 20 111u 0.91 wila

Y o dald A o
ﬂ')"lll?ill"lflllﬂ?"l HUUNATDURUVUUNANNFDNUGN
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a A o ad a J |
Msvdszansmnmiiadediannseting (e-Book) 1399 3191151054 Photoshop

tﬂl a d‘ ) [ (% =
INONANTONITODUY ﬁWWﬁUﬂgizﬂUﬂﬁ%ﬂNﬂﬂHW

{ J a A o ag a J
AN 12 Llﬁﬂ\‘lﬂ?ﬂigﬁﬂ‘ﬁﬂWWﬂu\iﬁﬂﬂlﬁﬂﬂ3’ﬂuﬂﬁ' Glumamaeﬂ%’zmmwuﬂﬂa

(n=3)

1atlsvasdi 1

W 2 3 4 5 6 7 8 9 10 11

v

U9

1atlsyaadi 2

12 13 14 15

16 17 18 19 20

7
a5z aenn 3

M1 22 23 24 25 26 27 28 29 30 31

o
ya1lszaenn 4

32 33 34 35

36 37 38 39 40

o
ya1lszaenn 5

21 22 23 24 25 26 27 28 29 30 31

=

2e
=)

o
a1z aenn 6

32 33 34 35

36 37 38 39 40

o 1 1 1 1 1 1 1 0
3 o 1 1 o0 o 1 1 1 1 1 o0 1 o0 1 1 1 1 1 1 1
d‘ = = d‘ = =) = 1
aun - A e AN AN 9 9am Wan15ao1 (60) MINIUNN
1 2 3 4 5 6 tlseasn
1 5 3 4 4 5 6 27 Vlllmu
2 8 9 8 8 8 8 49 WY
3 8 7 7 7 7 8 44 WNIU
AZLUUTIY 120
d‘ w U
AZUHUIDASUVDINTNATOUHAUITAIY 90 AIUTD 66.67

Y ya d‘ o | d Qs v
if')t’lﬁ%ﬂ]ﬂ\i&j!ﬁElHT’WIHHJ‘UT’Iﬂﬁf’J‘UNﬂ!‘VJi’l‘i}ﬂ‘lli%ﬁﬂﬂ 90 AItiad

66.67
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{ J a a @ adg a 4 1 1
MR 13 naasanlszaniammisdedannseiing lunmsnaaeslduuungudos

(n=6)
sz 1 alszaeni 2
i 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
y
U0
11 0 1 1 0 1 1 1 1 o 1 1 1 1 0 1 0 1 1 0
2 0 o0 1 1 1 0 1t 1 o 1 1 1 0 1 1 1 1 1 1 0
3 1 1 1 1 0 1 o0 1 1 1 1 0 1 1 1 1 1 1 1 0
4 1 1 1 0 1 o 1 1 1 1 1 1 1 1 1 0 1 1 1 0
s 1 0 1 1 1 o 1 o 1 1 1 1 1 1 0 1 1 1 1 0
6 1 1 1 1 o0 1 1 1 o 1 1 1 0 1 0 1 0 1 1 1
qadsEaadii 3 alszasdi 4
mifl 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40
"
U9
10 1 1 0o 1 o 1 1 1 1 1 1 1 1 0o 1 o0 1 1 1
2 1 0 1 o0 1 1 1 o0 1 1 1 1 0o 1 0o 1 0 1 1 1
3 0 1 1 1 1 o 1 1 o0 1 1 1 o 1 1 1 1 0 1 1
4 1 0 1 1 1 1 o 1 1 1 1 1 1 1 0o 1 1 1 1 1
s 1 0o 1 o0 1 1 1 1 1 1 1 0o 1 1 o0 1 0 1 1 I
6 1 1 0o o0 1 1 o0 1 1 1 0 o0 1 1 1 1 0 1 1 I
sz aeAi 5 alszaeni 6
mifl 41 42 43 44 45 46 47 48 49 S0 SI 52 53 54 55 56 5T S8 59 60
»
U0
1 1 1 1 0 1 1 1 0 1 0 1 1 1 1 1 1 1 0 1 0
2 1 0 0 0 1 1 1 1 1 1 0 0 1 1 1 1 1 1 1 0
3 1 0 1 1 1 1 1 0o 1 0o 1 1 1 1 0o 1 1 1 1 1
4 1 0o 1 0o 1 1 1 0 1 1 1 0 1 1 1 0 1 1 1 0
5 1 0 1 1 1 1 1 1 1 1 1 0 1 1 1 0 1 0 1 0
6 0 1 1 0 0 1 1 1 1 1 0 1 0 1 1 1 1 1 1 1
AUl el 1 qail 2 a3 qaf 4 gaf 5 qai 6 Wansaell (60) msrunnyalszasd
1 7 7 7 8 7 8 44 U
2 6 8 7 7 7 7 42 Taivin
3 8 8 7 8 7 9 47 i
4 8 8 8 9 9 7 47 U
5 7 8 8 7 8 7 45 U
6 8 7 7 7 7 8 44 i
AZUUUITIY 269
AZUUUINALVIININAADLHAUTEM 90 FINUTN 74.72
%’aaazmmé’ﬁwﬁﬁummmaamhm;né;ﬂﬂszmﬁ 90 fINA 83.33
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{ J a A o ag a J o 1 W ]
AN 14 Llﬁﬂ\‘lﬂ?ﬂigﬁﬂ‘ﬁﬂWWﬂu\iﬁ@ﬂlﬁﬂﬂ3@uﬂﬁ' Glumﬁmﬂaeﬂ%}ﬂmqumamﬂ

(n=130)

atlsvaadi 1 1atlsyaadi 2

uni 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
9
U9

1 1 1 1 1 0 1 1 1 1 1 1 1 1 1 1 1 0 1 1 1
2 1 1 1 1 1 1 1 1 1 1 1 0 1 1 1 0 1 1 1 1
3 1 1 1 0 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1
4 1 1 1 1 1 0 1 1 1 1 0 1 1 1 1 1 0 1 1 1
5 1 1 0 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1 1 1
6 1 1 1 1 1 0 1 1 1 1 1 1 1 1 1 1 1 1 1 1
7 1 1 1 1 0 1 1 1 1 1 1 0 1 1 1 1 1 1 1 1
8 1 1 1 1 1 0 1 1 0 1 1 1 1 1 1 1 1 1 1 0
9 1 1 1 1 1 0 1 1 1 1 1 1 1 1 1 1 1 1 1 0
10 1 1 1 1 1 1 1 0 1 1 1 1 1 0 1 1 1 1 1 1
11 1 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1 1 1

21 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
22 1 1 0 1 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1
23 1 1 1 0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 0
24 1 1 1 1 0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
25 1 1 1 0 1 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1
26 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1 1 1 0
27 1 1 1 1 0 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1
28 1 1 1 1 1 0 1 1 1 1 1 1 1 1 1 1 1 0 1 1
29 1 1 1 1 1 0 1 1 1 1 1 0 1 1 1 1 1 1 1 1
30 1 1 1 1 1 0 1 1 1 1 1 1 1 1 1 1 1 1 1 0
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(n=130)
sz 3 a5z 4
auil 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 30 40
)
1 1 1 0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 0
2 1 1 1 1 1 1 1 1 1 0 1 1 1 1 0 1 1 1 1 1
3 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1 1 1 1 1 1
4 0 1 1 1 1 0 1 1 1 1 1 1 1 1 1 1 1 1 0 1
5 1 1 1 1 1 1 0 1 1 1 1 1 1 1 1 1 1 0 1 1
6 1 1 1 0 1 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1
7 1 1 0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
8 1 1 1 1 1 0 1 1 1 1 1 1 1 1 1 1 1 1 0 1
9 1 1 0 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1 1 1
10 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1 1 0 1
11 0 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1 1 1
12 1 1 1 1 1 1 1 1 1 0 1 1 1 0 1 1 1 1 1 1
13 1 1 1 1 1 1 0 1 1 1 1 1 1 1 1 0 1 1 1 1
14 1 1 1 1 1 1 1 0 1 1 1 1 1 1 0 1 1 1 1 1
15 1 1 1 0 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1
16 1 1 1 1 1 1 0 1 1 1 1 1 1 1 1 1 1 1 1 0
17 1 1 1 1 1 1 0 1 1 1 1 1 1 1 0 1 1 1 1 1
18 1 1 1 0 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1
19 1 1 1 1 1 0 1 1 1 1 1 1 1 1 0 1 1 1 1 1
20 1 1 1 0 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1
21 1 1 1 1 0 1 1 1 1 1 1 1 1 1 1 1 0 1 1 1
22 1 1 0 1 1 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1
23 1 1 1 0 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1
24 1 1 1 1 0 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1
25 1 1 0 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1
26 1 1 1 1 0 1 1 1 1 1 1 1 1 1 1 1 1 0 1 1
27 1 1 1 1 1 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1
28 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1 1 0 1 1
29 1 1 1 1 1 0 1 1 1 1 1 1 1 0 1 1 1 1 1 1
30 1 0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 0 1 1 1
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AN 14 (99)

(n=130)

atlszasdi 5 1a1l5vasdi 6

AU 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60

7 1 0 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1 1
8 1 1 1 1 1 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1
9 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1

21 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1 1 1 0 1 1
22 1 1 0 1 1 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1
23 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1 0 1 1
24 1 1 1 1 1 1 1 0 1 1 1 1 0 1 1 1 1 1 1 1
25 1 1 0 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1
26 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 0 1 1 1 1
27 1 1 0 1 1 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1
28 1 1 1 1 1 1 1 1 0 1 1 1 1 1 1 1 0 1 1 1
29 1 1 0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
30 1 1 1 1 1 1 1 1 0 1 1 0 1 1 1 1 1 1 1 1
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=]
=
=h.

ho)
=h.

hO)
=h.

kS|
=D.

ho)
=h.

>

=n.
o

ho)

).

Q ! 1 2 1 Han1saou (60) MSHIUND
1 2 3 4 5 6 yalszaen
1 9 9 9 9 9 9 54 AU
2 10 8 9 9 9 10 55 U
3 9 9 9 10 9 9 55 AU
4 9 8 8 9 10 10 54 lairiu
5 9 9 9 9 10 10 56 AU
6 9 10 9 9 10 10 57 U
7 9 9 9 10 9 9 55 AU
8 8 9 9 9 10 9 54 lairiu
9 9 9 9 9 10 10 56 AU
10 9 9 9 9 9 9 54 U
11 10 9 9 9 10 9 56 U
12 9 9 9 9 9 9 54 AU
13 10 9 9 9 9 9 55 U
14 9 9 9 9 9 9 54 AU
15 10 9 9 9 9 9 55 AU
16 9 9 9 9 10 8 54 Tairu
17 9 9 9 9 9 9 54 AU
18 10 9 9 9 9 9 55 AU
19 9 9 9 9 9 9 54 AU
20 9 9 9 9 9 9 54 AU
21 10 10 9 9 9 9 56 AU
22 9 9 9 9 9 9 54 AU
23 9 9 9 9 9 9 54 AU
24 9 10 9 9 9 9 55 WU
25 9 9 9 9 9 9 54 AU
26 9 9 9 9 10 9 55 WU
27 9 9 10 9 9 9 55 AU
28 9 9 9 9 9 9 54 WU
29 9 9 9 9 9 10 55 AU
30 9 9 9 9 9 9 54 WU
AZLUUUTIY 1641
ﬂ::uuum?;mmmsmaauwé’as’%'ﬂu 90 AN 91.17
%’aﬂazﬁuamf_ﬁﬂuﬁﬁmuwm‘muvhunnc‘gﬂﬂﬁzmﬁ 90 712 90.00
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4 Wan1snagey ,
AUN DA o A D D
AU (60)  HAISEU (60)

1 27 54 27 729
2 27 55 28 784
3 29 55 26 676
4 28 54 26 676
5 31 56 25 625
6 32 57 25 625
7 27 55 28 784
8 26 54 28 784
9 29 56 27 729
10 27 54 27 729
11 27 56 29 841
12 26 54 28 784
13 26 55 29 841
14 27 54 27 729
15 26 55 29 841
16 25 54 29 841
17 23 54 31 961
18 26 55 29 841
19 24 54 30 900
20 25 54 29 841
21 25 56 31 961
22 24 54 30 900
23 23 54 31 961
24 23 55 32 1024
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A1519N 15 (919)

4 Wan1INAaou ,
AU L. o D D
nNoULIBYU (60) a3t (60)
25 26 54 28 784
26 25 55 30 900
27 27 55 28 784
28 26 54 28 784
29 26 55 29 841
30 24 54 30 900
59U 787 1641 854 24400
X 26.23 54.70

SD 2.12 0.83
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Frame Display Resource and Effects
No.
o ad a P
1. niladediannIeiind (E-book) Background | 1. #hwn
4 ” Color 2. muwasuiunes
(509 M35 1% 1151054 Photoshop
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- Font Color | 2. &wdesuas
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Frame Display Resource and Effects
No.
2. MMy au Background | 1.dwm
Color 2.279219
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Frame Display Resource and Effects
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3. a3y Background | 1.dvn
Color 2.a19010
Font Color | &
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Frame Display Resource and Effects
No.
4. galszasnmsiSend Backgr | 1.dvm
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Color
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Font am
Color
Interac | 1.aanudhand
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